
Syracuse City School District 
Career and Technical Education Program 

Course Syllabus 
MTC 100: Media Communications 100 - Introduction to 

Media Communications 
 

Program Overview 
The Media Communications program will help students develop the skills necessary for careers in 
television, radio, and electronic print media, including video production, news broadcasting, digital 
design, and media writing. Students will learn advanced professional skills in video, photo, audio, 
broadcasting, and journalism using industry standard hardware and software in the development 
and production of products. The program provides students with a combination of practical skills 
in using technology as well as encouraging innovation and creativity in applying those skills to 
explore and analyze current issues. Within this curriculum students will have the opportunity to 
earn NOCTI Television Production Certification as well as three credit hours from Onondaga 
Community College in both digital design and digital photography. Students who successfully 
complete the Media Communications curriculum will be prepared to move into entry level 
positions with media production firms or to continue their studies towards an associates or 
bachelor’s degree in the field that could lead to careers such as news reporter, anchor, producer, 
editor, advertising/public relations professional, or public spokesperson. 

 
Course Description 

This course is an introduction to the study of media, journalism and communication and blends 
written, oral, and graphic communication in a career-based environment. Students will learn the 
basics of video and photo methods, apply creative and professional framing techniques to their 
shots, use digital story telling principles, create shot lists, and digitally edit their footage into 
finished videos. Students will be introduced to the tools and skills used in broadcasting a daily 
newscast. The class structure is primarily project-based where students will use industry standard 
hardware and software. Hands-on project work will be supplemented with readings, writing, 
lectures, demonstrations, video, online research, and critiques. 

 
Pre-Requisites 

N/A 
 

Course Objectives 
1. Students will demonstrate an awareness of audio and video production career opportunities. 
2. Students will demonstrate knowledge of the basic software and hardware related to digital 

audio and video production. 
3. Students will demonstrate and apply basic audio and video production knowledge, 

terminology, techniques, and processes. 
4. Students will demonstrate knowledge of a variety of digital video and audio equipment 

including digital still and video cameras, and microphones. 
 
Integrated Academics 

N/A 
 
Equipment and Supplies 

• School will provide: Computers with industry standard software, broadcast studio facility 
with industry standard equipment, digital still and video cameras, microphones and all other 
peripherals needed for the media program. 

• Student will provide: N/A 
 
Textbook 

Harris, Phillip L. Television Production and Broadcast Journalism. Tinley Park, IL: Goodheart-
Willcox Co., Inc., 2012. 

In addition, students will be given supplemental material on the class teaching blog. 
 



Grading 
10% Homework 
10% Work Journal (DIN and Ticket Out the Door) 
20% Daily Class Work and Assignments 
30% Unit Tests/Quizzes 
30% Projects 
 

Additional Course Policies 
Students are expected to: 
• Meet all deadlines and be on time to class. Deadlines and being on time are a major part of a 

media professional’s job. 
• Produce their best original work. 
• Participate in class including contributing to discussions and critiquing their own and others’ 

work, as well as diligently working on their own projects during the class period.  
• Learn all the jobs, in front of and behind the camera. 
• Seek help when needed. Students who need to make up work or tests are responsible for 

getting their work from the instructor. 
• Be attentive during class, ask questions if they do not understand something, and offer their 

opinions.  
 
Course Calendar 
 

Quarter Units of Study 

1 • Unit 1: Orientation and Career Awareness 
• Unit 2: Computer Literacy  

2 • Unit 3: Basic Digital Photography 
• Unit 4: What is News? News and Script Writing 

3 • Unit 5: Introduction to the News Studio and Control Room 
• Unit 6: Non-Linear Editing 

4 • Unit 6: Non-Linear Editing (continued) 
• Unit 7: Graphic Design 

 



 
Syracuse City School District 

Career and Technical Education Program 
Scope and Sequence 

MTC 100: Media Communications 100 - Introduction to Media Communications 
 

Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment 

Evidence of Learning CCTC Standards NYS Standards 
Weeks 1-4 
 
Unit 1: 
Orientation and 
Career 
Awareness 

• What can the Career and 
Technical Education (CTE) 
classes at ITC offer students? 

• What is media today and how 
has it changed and evolved? 

• What are the differences in 
radio, television, cable, and 
the internet? 

• What are the best practices, 
policies and standards of 
media companies and 
broadcasters?  

• How are blogs used in 
media? 

• How is Google Drive used 
professionally in media 
today? 

• What is the employability 
profile for the media 
program? 

• Explore ITC Focus Areas. 
• Compare and contrast media today with 

media in the past. 
• Compare and contrast different types of 

media projects, including news broadcasts, 
photography, graphic design, advertising, 
and public service announcements (PSAs). 

• Explain media policies and standards. 
• Develop a blog as a learning journal. 
• Use Google Drive. 
• Complete an employability profile for 

media. 
• Exhibit professional behaviors. 

• Evaluation of Each CTE 
Program After Exploration 

• Unit Quizzes 
• Unit Exams 
• Creation of Online Blog 

and Posts 
• Sharing of Written Work 

on Google Drive 

Career Ready Practices 
CRP 1,2,4,6,8,10,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,6,7 
9-10SL 1,2,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,2,3,4,5 

Pathway Standards 
AR-AV 1,2,3 

Literacy 
RST 1,2,4 
WHST 2,4,6 

Weeks 5-8 
 
Unit 2: 
Computer 
Literacy 

• How is the computer 
keyboard used most 
effectively? 

• How are the menus on a 
basic Mac computer system 
navigated? 

• How is Microsoft Word used? 
• How are online internet 

applications used? 
• What is the importance of 

internet safety when using 
social media? 

• Use the basic PC computer system. 
• Navigate menus. 
• Access the internet. 
• Type and save documents. 
• Use search engines. 
• Explain internet safety.  
• Describe professional safe social media. 
• Describe and analyze the impact of 

cyberbullying. 

• Performance Assessment: 
Basic Operation of a 
Computer 

• Quiz on Internet Safety 
Including Social Media 
Sites 

• Unit Test 

Career Ready Practice 
CRP 1,2,4,5,8,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5 
9-10SL 1,2,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,2,4,6 

Pathway Standards 
AR-AV 2,3 

Literacy 
RST 1,2,4,6 
WHST 2,4,7 

Weeks 9-13 
 
Unit 3: 
Basic Digital 
Photography 

• What are the basic skills 
needed to use a point and 
shoot digital camera? 

• What are the basic skills 
needed to operate a digital 
video camera? 

• What is a tripod and how/why 
is it used? 

• How do professionals use 
composition when taking 
photos? 

• Identify parts of digital camera. 
• Demonstrate proper care of a camera. 
• Mount a camera on a tripod. 
• Describe various camera modes and their 

uses. 
• Use focusing options. 
• Explain macro photography. 
• Explain basic photo composition including: 

rule of 3rds, leading lines, and framing 
subjects. 

• Performance Task: 
Working with a Partner to 
Demonstrate Camera 
Identification and Tripod 
Use 

• Student Projects 
• Written Exam 

Career Ready Practice 
CRP 1,2,4,6,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,6 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment 

Evidence of Learning CCTC Standards NYS Standards 

• Use an on-camera flash. 
• Explain available and directional lighting. 
• Perform camera techniques including 

zoom, pan, tilt, dolly, truck, follow focus, 
rock zoom, and shift focus.  

• Compose using long shot (LS), close up 
(CU), extreme long shot (XLS), extreme 
close up (XCU), medium shot (MS), 
foreground, framed shot, high angle, low 
angle, point of view, over shoulder, and 
180 Degree Rule. 

• Perform steady, well composed hand-held 
techniques. 

• Record a reporter. 
• Operate camera during a location shoot. 
• Perform a “person on the scene” interview. 

Weeks 14-20 
 
Unit 4: 
What is News? 
News and Script 
Writing 

• What are the main elements 
of a news broadcast? 

• How is a successful script for 
a news broadcast created? 

• How is a news story written 
for print and online? 

• How is compelling lead 
written? 

• How is a sports story different 
than a news story? 

• Identify what constitutes news. 
• Identify parts of a news broadcast. 
• Research and write relevant news stories. 
• Compare writing news and sports stories. 
• Write a news story using the inverted 

pyramid method. 
• Explain and use “Who, What, Where, 

When, Why and How” when writing a news 
story. 

• Write interview questions. 
• Organize a news script. 
• Designate a target audience. 

• Unit Quiz on Identifying 
Parts of a News Broadcast 

• Student Projects - Writing 
News Stories 

• Unit Exam 
• Research Project and 

Presentation Explaining 
“What Is News”? 

Career Ready Practice 
CRP 1,2,4,6,7,8,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,5,6,7 

Weeks 21-27 
 
Unit 5: 
Introduction to 
the News Studio 
and Control 
Room 

• What are the various control 
room operations: equipment, 
staff, intercom system, and 
types of studio production? 

• How is the camera operated? 

• Identify the equipment used in a news 
studio and control room. 

• Explain the role of each staff member 
during a studio shoot. 

• Listen to and perform the director’s 
commands. 

• Connect microphones to camera and 
talent. 

• Demonstrate proper conduct during a live 
shoot. 

• Produce a two-camera shoot. 
• Write a comprehensive shot sheet. 
• Perform the various roles in the newsroom 

including camera operator, director, and 
anchor. 

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practice 
CRP 1,2,4,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,3,6 

Pathway Standards 
AR-AV 2,3,4 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,6 

Weeks 28-33 
 
Unit 6:  
Non-Linear 
Editing 

• What are the uses of non-
linear editing? 

• What are the components of 
iMovie, including work area, 
time, capturing, audio, and 
outputting? 

• Use iMovie to tell a multi-media story. 
• Utilize menus. 
• Learn about Setup and Timeline. 
• Control size of frames. 
• Import and trim clips. 
• Insert special effects (SFX). 

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practice 
CRP 1,2,4,6,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards Literacy 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment 

Evidence of Learning CCTC Standards NYS Standards 

• How is iMovie used to tell a 
multi-media story? 

• Add transitions. 
• Control audio. 
• Import and export movies. 
• Control frame ratio. 
• Create titles. 
• Apply filters. 
• Navigate the menu. 
• Capture video. 
• Insert audio. 
• Set audio levels. 
• Perform wipes/dissolves. 
• Edit a countdown. 
• Edit a PSA. 
• Describe how pacing affects an audience. 
• Perform advanced editing techniques. 

AR-AV 2,3,4 RST 1,2,4,9 
WHST 2,4,6,7 

Weeks 34-40 
 
Unit 7:  
Graphic Design 

• What are the uses for Adobe 
Photoshop CS6 and Adobe 
Bridge? 

• How are choices about 
typography, font uses, and 
color selections made? 

• What are the properties of 
color? 

• Perform the basic functions of Adobe 
Photoshop and Bridge including: 
o Selecting: Marquee, lasso, magic 

wand. 
o Drawing: paintbrush, pencil, airbrush, 

eraser type. 
o Transforming: scale, rotate. 
o Changing View: hand, zoom. 

• Use menu choices including: 
o New, open, close, save. 
o Edit: undo, copy, paste, transform. 
o Image: mode, adjustments. 
o Filters. 
o Window: show color, swatches, layers. 
o Palettes: color, swatches, layers. 
o Selecting/moving. 
o Layers: selecting/stack order/opacity. 
o Foreground/background colors. 
o Printing the image. 

• Crop and size images using Adobe 
Photoshop and post to web-based blog. 

• Identify file formats with respect to printing 
and print presentation including pixels, 
megapixels, dots per inch (DPI), and pixels 
per inch (PPI). 

• Identify types of fonts and sizes. 
• Explain color selections. 
• Explain what scanning area means. 
• Produce graphic pages, advertising layout, 

and a text hierarchy. 

• Portfolio 
• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practice 
CRP 1,2,4,6,8,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 

Literacy 
RST 1,2,4,9 
WHST 2,4,6,7 

 



Syracuse City School District 
Career and Technical Education Program 

Course Syllabus 
MTC 200: Media Communications 200 - Digital Multimedia 

 
Program Overview 

The Media Communications program will help students develop the skills necessary for careers in 
television, radio, and electronic print media, including video production, news broadcasting, digital 
design, and media writing. Students will learn advanced professional skills in video, photo, audio, 
broadcasting, and journalism using industry standard hardware and software in the development 
and production of products. The program provides students with a combination of practical skills 
in using technology as well as encouraging innovation and creativity in applying those skills to 
explore and analyze current issues. Within this curriculum students will have the opportunity to 
earn NOCTI Television Production Certification as well as three credit hours from Onondaga 
Community College in both digital design and digital photography. Students who successfully 
complete the Media Communications curriculum will be prepared to move into entry level 
positions with media production firms or to continue their studies towards an associates or 
bachelor’s degree in the field that could lead to careers such as news reporter, anchor, producer, 
editor, advertising/public relations professional, or public spokesperson. 
 

Course Description 
Students will learn skills in video, photo, audio, broadcasting, and journalism with a focus on 
developing a daily news program. Students will build on the foundation from MTC 100: Media 
Communications 100 – Introduction to Media Communications to learn more advanced video and 
photo methods, apply creative and professional framing techniques to their shots, use digital story 
telling principles, create shot lists, and digitally edit their footage into finished videos. The class 
structure is primarily project-based where students will use industry standard hardware and 
software. Hands-on project work will be supplemented with readings, writing, lectures, 
demonstrations, video, online research, and critiques. 

 
Pre-Requisites 

MTC 100: Media Communications 100 – Introduction to Media Communications 
 
Course Objectives 

By the end of this course students will: 
1. Successfully produce a daily news show. This includes students performing the following 

roles: director, floor director, copy editor, camera operator, video editor, writer, teleprompter 
operator, switcher/board operator. 

2. Apply effective team communication and management skills to complete the video process 
from pre-production script development, through the production capture of quality video 
image and audio. 

3. Use a digital video camera to capture images using the following camera techniques: rule of 
thirds, leading look, leading lines, close-up, establishing shot, cut-away, basic shot sequence, 
tilt, pan, and zoom. 

4. Select and execute the proper framing of a video shot; demonstrate ability to create different 
compositions.  

5. Demonstrate knowledge of the three phase production processes (preproduction, production, 
post-production). 

6. Demonstrate ability to scout locations and prepare location schematics. 
7. Identify the basic elements of a quality audio signal. Select and use appropriate audio 

(microphone) techniques. 
8. Identify the role of the editor in production process. Evaluate and select original footage as 

dictated by the scene/script message; choose the editing style that best meets that script 
format. 

9. Capture digital video and edit videos with non-linear editing software. Perform the match-cut 
edit by cutting within scene, on the action and between the action. Use and manipulate 
transitions and effects in editing software. 



Integrated Academics 
N/A 

 
Equipment and Supplies 

• School will provide: Media Lab – PC Computers, Video Camcorders, Point and Shoot 
Cameras, DSLR Cameras, Microphones, SD Cards.  
TV Studio – HD Cameras, Teleprompters, Video Board, Graphics Computer, Microphones, 
News Desk, Green Screen. 

• Student will provide: Writing utensil, news stories from magazines / newspapers. 
 
Textbook 

Harris, Phillip L. Television Production and Broadcast Journalism. Tinley Park, IL: Goodheart-
Willcox Co., Inc., 2012. 

 
Grading 

Students enter the classroom each day with a 100% (A) grade. To maintain that grade point 
average, it is expected that all assignments will be done each day with the highest level of 
professionalism, showing a positive attitude, and to the student’s best effort. Students will be 
given a grade at the midpoint and end of each marking period. Students can check the computer-
based class grade book (E-School) regularly to check grades. If students miss points on an 
assignment, they will be able to see where they missed points, and make up those points during 
the next class. It is the student’s responsibility to check their grades in order to make up points. 

 
5% Participation 
25% Class work 
15% Worksheets 
40% Projects 
15% Quizzes and Tests 

 
Additional Course Policies 

When you enter the Media Lab, you have entered a professional working environment. When in 
the lab, it is expected that everyone will act in the manner found in all professional media 
companies. 
 

Course Calendar 
 

Quarter Units of Study 

1 
• Unit 1: Career Awareness 
• Unit 2: What is News? - News and Script Writing 
• Unit 3: TV Industry Overview 

2 • Unit 3: TV Industry Overview (cont.) 
• Unit 4: Introduction to TV Studio and Control Room 

3 • Unit 5: Non-Linear Editing 
• Unit 6: Studio Newscasting 

4 
• Unit 7: Advanced Non-Linear Editing 
• Unit 8: Advanced Studio Newscasting - Engineering and 

Troubleshooting 
 



 
Syracuse City School District 

Career and Technical Education Program 
Scope and Sequence 

MTC 200: Media Communications 200 - Digital Multimedia 
 

Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment  

Evidence of Learning CCTC Standards NYS Standards 
Weeks 1-4 
 
Unit 1:  
Career Awareness 

• What career opportunities are 
available in the video 
production field? 

• What skills are needed for 
each type of job in media 
communications? 

• What are some post-
secondary education 
programs in media 
communications? 

• What is the value of keeping a 
portfolio? 

• How are blogs used in 
media? 

• How is Google Drive used 
professionally in media 
today? 

• What is the employability 
profile for this media 
program? 

• Identify career opportunities in the video 
production field.  

• Research pay scales and the skills 
needed for each type of job in media 
communications. 

• Produce a talk show about careers in the 
field with special guests. 

• Investigate post-secondary education in 
media communications. 

• Develop a portfolio of research. 
• Keep a journal of research with an online 

blog. 
• Produce and post a video that 

demonstrates proper job interview 
techniques. 

• Identify and demonstrate professional 
behaviors in media communications that 
influence employability. 

• Unit Quizzes and Exams 
• Online Blog 
• Use of Google Drive for 

Writing and Sharing 
Projects 

Career Ready Practices 
CRP 1,2,4,6,7,8,10,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,6,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,3,4,5,6 

Pathway Standards 
AR-AV 1,2,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,6,7,8,9 

Weeks 5-8 
 
Unit 2:  
What is News? 
News and Script 
Writing 

• What are the main elements 
of a news broadcast? 

• How is a successful script 
created for news broadcast? 

• How a news story written for 
print and online? 

• How is a compelling lead 
written? 

• How is a sports story different 
from a news story? 

• Explain what constitutes news. 
• Describe the parts of a news broadcast. 
• Research and write relevant news stories. 
• Compare writing news and sports stories. 
• Write a news story using the inverted 

pyramid method. 
• Use “Who, What, Where, When, Why and 

How” when writing a news story. 
• Write interview questions. 
• Organize a news script. 
• Designate a target audience. 

• Student Projects-Writing 
News Stories 

• Research Project and 
Presentation Explaining 
“What is News”? 

Career Ready Practices 
CRP 1,2,4,6,7,8,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,6,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,6,7,8,9 

Weeks 9-13 
 
Unit 3: 
TV Industry 
Overview 

• What are the stages of 
production? 

• What are the roles of a TV 
production unit? 

• Where is TV production 
used? 

• What does it mean to be 
employable? 

• Identify the types of production and where 
they are used. 

• Explain the stages of production. 
• Describe the role of each staff member in 

TV production. 
• Identify where and when to shoot. 
• Maintain a position as a shop manager. 
• Give an oral presentation that 

incorporates internet research about the 
TV industry. 

• Identify and demonstrate professional 

• Performance Task  
• Student Projects 
• Written Exam 

Career Ready Practices 
CRP 1,2,3,4,6,7,8,10,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,6,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,2,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,3,4 
WHST 2,4,6,7,8,9 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment  

Evidence of Learning CCTC Standards NYS Standards 
behaviors in TV production. 

• Explain the traits that employers are 
looking for in TV production. 

• Describe safety in TV production including 
procedures for shop, electrical, and 
lighting safety. 

Weeks 14-20 
 
Unit 4: 
TV Studio and 
Control Room 

• What are the various control 
room operations: equipment, 
staff, intercom system, and 
types of studio production and 
how are they used? 

• How is the camera operated? 

• Identify the equipment used in a news 
studio and control room. 

• Explain the role of each staff member 
during a studio shoot. 

• Listen to and perform the director’s 
commands. 

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,3,7 
WHST 2,4,6,7,8,9 

Weeks 21-23 
 
Unit 5: 
Non-Linear Editing 

• What are the uses of non-
linear editing? 

• What are the components of 
Adobe Premiere, including 
work area, time, capturing, 
audio, and outputting? 

• How is Adobe Premiere used 
to tell a multi-media story? 

• Use Adobe Premiere to tell a multi-media 
story. 

• Utilize menus. 
• Learn about Setup and Timeline. 
• Control size of frames. 
• Import and trim clips. 
• Insert special effects (SFX). 
• Add transitions. 
• Control audio. 
• Import and export movies. 
• Control frame ratio. 
• Create titles. 
• Apply filters. 
• Navigate the menu. 
• Capture video. 
• Insert audio. 
• Set audio levels. 
• Perform wipes and dissolves. 

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practices 
CRP 2,4,6,8,11 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,3,4,7 
WHST 2,4,6,7,8,9 

Weeks: 24-29 
 
Unit 6: 
Studio 
Newscasting 

• What are the various control 
room operations: equipment, 
staff, intercom system, and 
types of studio production? 

• How is the camera operated? 

• Identify the equipment used in a news 
studio and control room. 

• Explain the role of each staff member 
during a studio shoot. 

• Listen to and perform the director’s 
commands. 

• Connect microphones to camera and 
talent. 

• Demonstrate proper conduct during a live 
shoot. 

• Produce a two-camera shoot. 
• Write a comprehensive shot sheet. 
• Explain the uses of Chroma key. 
• Set audio levels. 
• Act in the roles of camera operator, 

director, anchor, etc.  

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,3,4,7 
WHST 2,4,6,7,8,9 

Weeks 30-34 • What are the components of • Edit a countdown. • Performance Task Career Ready Practices ELA 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment  

Evidence of Learning CCTC Standards NYS Standards 
 
Unit 7: 
Advanced Non-
Linear Editing 

Adobe Premiere, including 
work area, time, capturing, 
audio, and outputting? 

• How is Adobe Premiere used 
to tell a multi-media story? 

• Create Color Bars and Slate. 
• Edit a Public Service Announcement 

(PSA). 
• Describe how pacing affects an audience. 
• Edit a news package with stand-up and B-

roll. 

• Student Projects 
• Written Exam 

CRP 2,4,6,8,11 9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,3,4,7 
WHST 2,4,6,7,8,9 

Weeks 35-40 
 
Unit 8: 
Advanced Studio 
Newscasting -: 
Engineering and 
Troubleshooting 

• What are the various control 
room operations: equipment, 
staff, intercom system, and 
types of studio production? 

• How is the camera operated? 
• How does engineering and 

troubleshooting apply in a 
studio shoot? 

• Listen to and perform the director’s 
commands. 

• Connect microphones to camera and 
talent. 

• Demonstrate proper conduct during a live 
shoot. 

• Produce a two-camera shoot. 
• Write a comprehensive shot sheet. 
• Set audio Levels. 
• Act in the roles of camera operator, 

director, anchor, etc. 
• Reset light schemes. 
• Check cables for continuity. 
• Check AC line voltage. 

• Performance Task 
• Student Projects 
• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
9-10R 1,2,4,7 
9-10W 2,4,5,7 
9-10SL 1,2,5,6 
9-10L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 1,2,3,4 

Literacy 
RST 1,2,3,4,7 
WHST 2,4,6,7,8,9 

 



Syracuse City School District 
Career and Technical Education Program 

Course Syllabus 
MTC 300: Media Communications 300 – Advanced Media 

 
Program Overview 

The Media Communications program will help students develop the skills necessary for careers in 
television, radio, and electronic print media, including video production, news broadcasting, digital 
design, and media writing. Students will learn advanced professional skills in video, photo, audio, 
broadcasting, and journalism using industry standard hardware and software in the development 
and production of products. The program provides students with a combination of practical skills 
in using technology as well as encouraging innovation and creativity in applying those skills to 
explore and analyze current issues. Within this curriculum students will have the opportunity to 
earn NOCTI Television Production Certification as well as three credit hours from Onondaga 
Community College in both digital design and digital photography. Students who successfully 
complete the Media Communications curriculum will be prepared to move into entry level 
positions with media production firms or to continue their studies towards an associates or 
bachelor’s degree in the field that could lead to careers such as news reporter, anchor, producer, 
editor, advertising/public relations professional, or public spokesperson. 
 

Course Description 
Advanced media is the capstone media class in which students will build on the foundation from 
MTC 100: Media Communications 100 – Introduction to Media Communications and MTC 200: 
Media Communications 200 – Digital Multimedia to apply their vast knowledge of video, photo, 
and design while utilizing industry standard equipment to create professional quality material for 
authentic audiences around Syracuse. This experience will prepare students to take on entry-
level professional roles in media firms or to continue on in the higher education media field. The 
class structure is primarily project-based where students will use industry standard hardware and 
software. Hands-on project work will be supplemented with readings, writing, lectures, 
demonstrations, video, online research, and critiques. 

 
Pre-Requisites 

MTC 100: Media Communications 100 – Introduction to Media Communications 
MTC 200: Media Communications 200 – Digital Multimedia 

 
Course Objectives 

Students will: 
• Apply effective team communication and management skills to complete the video 

process from pre-production script development, through the production capture of 
quality image and audio.  

• Understand the following video terms and apply the technique or concept using a digital 
camera:  storyboarding, shot list, key light, backlight, fill light.  

• Use a digital video camera to capture images using the following camera techniques: rule 
of thirds, leading look, leading lines, close-up, establishing shot, cut-away, basic shot 
sequence, tilt, pan, and zoom. 

• Execute the proper framing of a video shot; demonstrate ability to create different 
compositions. 

• Demonstrate knowledge of the three phase production processes (preproduction, 
production, post-production).  

• Identify the project clients, their needs, and target audience. 
• Create scripts, storyboards, timelines, schedules, and budgets. 
• Demonstrate ability to scout locations and prepare location schematics. 
• Identify the basic elements of a quality audio signal. Select and use appropriate audio 

(microphone) techniques. 
• Identify the role of the editor in production process. Evaluate and select original footage 

as dictated by the scene/script message; choose the editing style that best meets that 
script format. 



• Capture digital video and edit videos with non-linear editing software (Adobe Premiere). 
 
Integrated Academics 

N/A 
 
Equipment and Supplies 

• School will provide: Media Lab – PC Computers, Video Camcorders, Point and Shoot 
Cameras, DSLR Cameras, Microphones, SD Cards.  
TV Studio – HD Cameras, Teleprompters, Video Board, Graphics Computer, Microphones, 
News Desk, Green Screen. 

• Student will provide: Writing utensil, news stories from magazines / newspapers. 
 
Textbook 

Harris, Phillip L. Television Production and Broadcast Journalism. Tinley Park, IL: Goodheart-
Willcox Co., Inc., 2012. 

 
Grading 

Students enter the classroom each day with a 100% (A) grade. To maintain that grade point 
average, it is expected that all assignments will be done each day with the highest level of 
professionalism, showing a positive attitude, and to the student’s best effort. Students will be 
given a grade at the midpoint and end of each marking period. Students can check the computer-
based class grade book (E-School) regularly to check grades. If students miss points on an 
assignment, they will be able to see where they missed points, and make up those points during 
the next class. It is the student’s responsibility to check their grades in order to make up points. 

 
5% Participation 
25% Class work 
15% Worksheets 
40% Projects 
15% Quizzes and Tests 

 
Additional Course Policies 

When you enter the Media Lab, you have entered a professional working environment. When in 
the lab, it is expected that everyone will act in the manner found in all professional media 
companies. 
 

Course Calendar 
 

Quarter Units of Study 

1 • Unit 1: Career Awareness 
• Unit 2: Non-Linear Editing 

2 • Unit 3: Directing 
• Unit 4: Advertising 

3 
• Unit 5: TV Graphics 
• Unit 6: Advanced Switcher 
• Unit 7: Advanced Camera Applications 

4 

• Unit 8: Advanced Audio 
• Unit 9: Advanced Lighting 
• Unit 10: Advanced Studio 
• Unit 11: News/Event Videography 
• Unit 12: Archiving 

 



Syracuse City School District 
Career and Technical Education Program 

Scope and Sequence 
MTC 300: Media Communications 300 – Advanced Media 

 
Time Frame 

Unit of Study Key Questions Key Learning Targets 
(Students will know and be able to) 

Assessment  
Evidence of Learning CCTC Standards NYS Standards 

Weeks 1-4 
 
Unit 1: 
Career Awareness 

• What is the purpose of a 
professional portfolio? 

• What experiences can be 
beneficial for college admissions 
and employment? 

• What should be included in a 
professional resume and cover 
letter? 

• What are skills on the 
employability profile for the media 
program? 

• What are media studies? 
• How is Google Drive used 

professionally in media today? 

• Develop an electronic portfolio of work. 
• Produce a demo reel. 
• Complete an internship. 
• Complete project(s) for local 

business/media outlet. 
• Write a research paper on one job title. 
• Update resume. 
• Write a cover letter. 
• Produce and post a news report about 

media studies. 

• Unit Quizzes 
• Unit Exams 
• Resume and Cover Letter 
• Creation of Online Blog 

and Posts 
• Sharing of Written Work on 

Google Drive 

Career Ready Practices 
CRP 1,2,4,8,10 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,2,3,4,5 

Pathway Standards 
AR-AV 1 
AR-JB 1,2 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,5,6,7 

Weeks 5-8 
 
Unit 2:  
Non-Linear Editing 

• What are the uses for non-linear 
editing? 

• What are the components of 
Adobe Premiere, including work 
area, time, capturing, audio, and 
outputting? 

• How is Adobe Premiere used to 
tell a multi-media story? 

• Demonstrate basic navigational 
techniques. 

• Identify parts of the Adobe Premiere 
screen. 

• Store footage in bins. 
• Label files. 
• Create A/B timeline. 
• Use multiple audio tracks. 
• Add special effects. 
• Create and render titles. 
• Export movie. 
• Explain what “Plug-Ins” are. 
• Edit using time code numbers. 
• Insert clips using time code. 
• Save and label reels, files, and bins. 
• Employ tool navigation. 
• Create a title. 
• Incorporate a graphic image. 

• Performance Task: Editing 
of Pre-Existing Footage 
and Footage Recorded for 
Edit 

• Student Projects: Narrative 
Films, News Packages, 
ENGs (Electronic News 
Gathering), Video Profiles 

• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,6,7 

Weeks 9-13 
 
Unit 3:  
Directing 

• Why is communication the key to 
successful operation? 

• How can a director delegate 
responsibilities effectively? 

• Demonstrate the ability to motivate and 
rehearse a cast of characters. 

• Work diligently with technical crew. 
• Mark script.  
• Call commands effectively in studio. 
• Scout location scenes using proper 

terminology.  
• Direct a scene from an existing script. 

• Performance Task: 
Directing and Delegating 
Tasks Done as a 
Team/Group 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 3,4 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,6,7 

Weeks 14-20 
 
Unit 4:  

• What is the goal of advertising? 
• What are demographics? 

• Explain types of advertising. 
• Explain how a commercial gets 

• Student Projects: Creating 
Advertisements - Poster, 

Career Ready Practices 
CRP 1,2,4,6,7,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 Cluster Standards 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment  

Evidence of Learning CCTC Standards NYS Standards 
Advertising • What is target audience? approved by agency. 

• Describe audience characteristics. 
• Explain how an ad agency targets an 

audience. 
• Explain how research improves product 

sales. 
• Compare large and small market ads. 
• Produce a commercial for a new 

product or existing one. 

Magazine, Brochure, Radio 
Spot, TV Spot 

• Research Projects – Study 
on Various Advertisements 
of Various Formats 

• Written Exam 

AR 1,6 11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,6,7,8,9 
WHST 2,4,5,6,7 

Weeks 21-23 
 
Unit 5:  
TV Graphics 

• How are graphics created and 
used? 

• What are the differences between 
computer graphics (CGs) and 
stills?  

• What elements must be 
considered when creating 
graphics? 

• Identify and explain hue, saturation, 
and luminance. 

• Identify secondary and primary colors. 
• Use software programs to create 

graphic pages. 
• Create the following types of graphics: 

Lower 3rd, Title Page, Slate Page, 
Opening Credits, Closing Credits, Bug. 

• Student Projects: Creating 
Graphics for News and 
TV/Film Projects 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,7 

Weeks 24-25 
 
Unit 6:  
Advanced Switcher 

• What are transitions? 
• What are director commands a 

switchboard operator must know? 
• What is chroma keying and 

why/how is it used? 
• What effects are appropriate for 

professional shoots? 

• Perform transitions: cut, wipe, super, 
fade, dissolve. 

• Change/control inputs. 
• Follow director’s commands. 
• Key titles. 
• Set up and record chroma key with live 

video. 
• Set up and record chroma key with still 

shot. 
• Act as technical director for: news 

program, 3-cam narrative, talk show. 

• Performance Task: 
Performing Switchboard 
Tasks for Live Video Shoot 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,7 

Weeks 26-29 
 
Unit 7:  
Advanced Camera 
Applications 

• What is white balancing and why 
is it important? 

• What is the exposure triangle? 
• What is depth of field? 
• What filters are used on different 

cameras? 

• Navigate internal menus. 
• Control exposure using exposure 

triangle and reading zebra pattern. 
• Use depth of field to compose visually 

appealing shots. 
• Conduct an EFP (Electronic Film 

Production) shoot on campus. 
• Shoot news package on location. 
• White balance. 
• Calibrate lens. 
• Use filters to create an artistic shot. 
• Identify types of filters. 
• Explain purpose of filters. 

• Performance Task: 
Performing Live Event 
Video Shoot with 
Automatic Camera 
Operations 

• Student Projects: Creating 
a Visual Story Using 
Camera Techniques - Shot 
Types, Camera 
Movements, Exposure, 
and Depth of Field 

• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7,9 
WHST 2,4,6,7 

Weeks 30-31 
 
Unit 8: 
Advanced Audio  

• What are the different types of 
microphones? 

• What mics are used for: Voice, 
Music, Nat Sound and why? 

• Identify microphones used. 
• Choose best microphone for shoot. 
• Define each microphone’s properties. 
• Identify parts of an audio mixer. 
• Equalize signal. 
• Describe wave properties. 
• Explain radio frequencies. 
• Connect audio mixer to editor. 

• Performance Task: Live 
Radio Coverage  

• Student Projects: Creating 
a Podcast 

• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,5,6,7 



Time Frame 
Unit of Study Key Questions Key Learning Targets 

(Students will know and be able to) 
Assessment  

Evidence of Learning CCTC Standards NYS Standards 

• Perform well-read scripts. 
• Record audible sound for narration. 

Weeks 32-33 
 
Unit 9: 
Advanced Lighting 

• What is three-point lighting? 
• What is the difference between 

direct and diffused lighting? 
• What is lighting scheme/diagram? 

• Explain and demonstrate safety 
regulations. 

• Explain and demonstrate how to control 
light intensities.  

• Identify light accessories. 
• Identify and select the appropriate light 

source. 
• Take reflective and directional 

readings. 
• Use available light on location. 
• Design a light scheme for set. 
• Produce light diagrams. 
• Change light intensities. 

• Performance Task: Light 
Studio Production and 
Field Production 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,7 

Weeks 33-34 
 
Unit 10: 
Advanced Studio 

• What are standard practices 
related to broadcast journalism? 

• Design a set according to script 
requirements. 

• Identify set pieces. 
• Explain function of set pieces. 
• Block characters according to script. 
• Block cams according to script 

requirements. 
• Make scripts change. 

• Performance Task: 
Perform Live Year-In-
Review Newscast with 
Segment from Each News 
Job - Director, Producer, 
Camera Operator, 
Graphics, Teleprompter, 
Floor Manager, Lighting, 
and Anchor  

• Written Exam 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,5,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,7 

Weeks 35-39 
 
Unit 11: 
News/Event 
Videography 

• What is the difference between 
studio and field production? 

• What are the differences between 
scripted and event videography? 

• What is an ENG /News Package? 
• What is B-roll? 

• Package a news piece. 
• Record B-roll. 
• Use terms of trade. 
• Explain where and when they can 

shoot. 
• Direct a news program. 
• Perform play-by-play report from school 

event. 
• Cover a campus story. 
• Explain types of news stories. 
• Explain covering live events. 

• Performance Task: 
Perform Field Production 
from Live Event 

• Performance Task: Create 
News Program Covering 
Senior Year of High School 

Career Ready Practices 
CRP 1,2,4,6,8,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,6 

Pathway Standards 
AR-AV 2,3,4 
AR-JB 2,3,4 

Literacy 
RST 1,2,4,7 
WHST 2,4,7 

Weeks 39-40 
 
Unit 12: 
Archiving 

• Why is archiving essential in 
visual arts? 

• Identify types of archiving mediums. 
• Organize and maintain an archive 

library. 
• Navigate and utilize digital archiving 

technology. 
• Create a digital archive of work. 

• Final Portfolio Career Ready Practices 
CRP 1,2,4,6,8,10,11,12 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,5,6,7 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 1,5,6 

Pathway Standards 
AR-AV 1,2,3,4 
AR-JB 12,3,4 

Literacy 
RST 1,2,4,7,8,9 
WHST 2,4,5,6,7 

 



MTC 400: Media Communications 400, Part I 
PHO 111: Digital Photography 

Onondaga Community College 
 
Course Information: 

• PHO 111 Digital Photography, section 401 
• 3 credits 

 
Course Description: 

This non-major course is designed to cover the basics of digital photography. Students will be introduced to 
digital camera functions. Assignments will address composition, design, color theory and the history of 
photography to help students work creatively with their digital cameras. Students will be introduced to image 
editing software (Photoshop) for color correction, image manipulation, and digital output. Class time will 
include lecture, demonstration, in-class shoots, critique and hands on digital lab instruction. Writing and 
reading assignments as appropriate to the discipline are part of this course. 

 
Course Objectives: 

• Exhibit technical mastery of consumer level digital cameras. 
• Apply skills in areas such as composition and color theory to the creation of photographic work. 
• Demonstrate studio lighting techniques in creation of digital imagery. 
• Demonstrate a basic knowledge of larger movements in the history of photography. 
• Demonstrate proficiency in use of image editing software to prepare images for optimal quality output. 
• Create and maintain an online blog or website to display your work. 

 
Attendance and Participation 

Attending and participating in class is mandatory for success in a studio art course. Not all work will be 
completed during the scheduled class time. Students must spend time outside of class to successfully 
complete the assignments. 
 
Students are allowed two absences for any reason excused or otherwise before their grade is affected. After 
the second absence your entire earned grade will drop one letter grade. After the third absence your grade 
will drop two letter grades. After the fourth absence you will fail the course. 
 
Fifteen minutes past the scheduled class time is considered late. Three late arrivals equal one absence. 
Leaving class early and medical related absences will be handled on a case-by-case basis. 
 
If a class is missed, students are responsible to collect missed notes, assignments, or other materials from 
a classmate. In the case of absences, assignments will still be due on the set due date. It is the student’s 
responsibility to contact me to discuss options. 
 
It is the student’s responsibility to inform the instructor of an anticipated absence ahead of time. The 
instructor may require students to document their absence. Students are responsible for making up any 
missed work, as allowed by the instructor’s syllabus and/or course outline. 
 
Excessive absences, tardiness, and disrespectful attitude or behavior will result in expulsion from the class. 
The college-wide attendance policy will be implemented in cases of non-attendance or excessive absences 
whereby students are subject to an administrative withdrawal. 
 
The College’s attendance policy and financial aid regulations require instructors to award the grade of 
“Never Attended” (NA) for students who never attend through the first three weeks of classes in a full 
semester. Additionally, for students who cease to attend after that time period, and who, in the professional 
judgment of the faculty member, are no longer de facto students in the course at the midpoint of the term, 
faculty shall assign an “X.” This shall remove the student from the course. 
 
The "X" grade will carry no quality points and will not be computed into the student’s grade-point-average, 
nor will the credit counts toward overall load (i.e. full-time). 
 
A grade of X or a student-initiated withdrawal may affect a student’s current or future financial aid, veteran’s 
eligibility, and/or student visa status. Students should consult the Financial Aid Office to learn both short and 
long-term consequences. 
 
Non-attendance does not relieve students of their financial responsibility for tuition and fees. Deadlines for 



courses other than 15 weeks in length are adjusted proportionally. 
 

For more information, visit http://students.sunyocc.edu/index.aspx?menu=942&id=24577 
 
Grading Procedure: 

Your course grade will be made up of 16 critiqued projects, a midterm and final portfolio presentation. The 
grade breakdown is listed below. 

750 points Regular Semester Assignments 
150 points Final Portfolio-All Semester Assignments + 5 additional 
  25 points Reading Response/Semester Written Component 50 points - Midterm Exam 
  25 points Class Participation/Attendance Total – 1000 points 

 
Grading Scale: 

A+- 950-1000 B+ 850-890 C+ 750-790 D+ 650-690 
A- 900-940 B- 800-840 C- 700-740 D- 600-640 

 
Class Rules: 

The use of cell phones, headphones, or other electronic devices during class is not permitted (unless written 
documentation stating such academic accommodations are provided). 
 
You may not leave the room during an exam for any reason until you are done and have handed it in; you will 
forfeit the exam entirely should you choose to violate this rule. Plan accordingly. 
 
All assignments must be typewritten and stapled. Hand-written or electronic assignments will not be 
accepted. 
 
Leaving class regularly or early (even if you’ve signed in) will be noted and will result in grade penalties. 
 
You are responsible for the cleanup and disposal of your trash and recyclables. 

 
Academic Integrity 

Current and prospective students at Onondaga Community College are expected to adhere to the values of 
intellectual and academic honesty and integrity. Violations of academic honesty will not be tolerated. Policies 
and penalties for violations of academic honesty are established by each academic department. 
 
Academic dishonesty describes a wide range of behaviors; the following is offered as a working definition. 
Academic dishonesty includes but is not limited to: 
 
Cheating. 

Intentionally using unauthorized materials, information, or study aids in any work submitted (e.g. 
using crib notes, copying another’s work during tests, or collaborating with others on out-of-class 
assignments without permission). 

Fabrication. 
Intentionally falsifying or misrepresenting information derived from another source in an assignment 
(e.g., making up sources for the bibliography of a paper or faking the results of a laboratory 
assignment). 

Plagiarism. 
Deliberately adopting or reproducing ideas, words, or statements of another person as one’s own 
without acknowledgement (e.g., paraphrasing or summarizing a source without acknowledgement, 
turning in a paper written by another person, buying a paper from a commercial source, failing to 
properly attribute quotations within a paper, or submitting the same paper for credit in more than one 
course without the instructor’s permission [self-plagiarism]). 

Facilitating Academic Dishonesty. 
Intentionally helping another engage in academic dishonesty. 

Misrepresentation. 
Providing false information to an instructor concerning an academic exercise (e.g., giving a false 
excuse for missing a test or deadline or falsely claiming to have submitted a paper). 

Failure to Contribute. 
Taking credit for participation in a collaborative project while failing to do one’s fair share. 

Sabotage. 
Preventing others from completing their work (e.g., disturbing someone’s lab experiment or removing 
materials from a reserved reading file so that others may not use them). 

 
For more information, visit http://students.sunyocc.edu/index.aspx?menu=942&id=24576 



 
Course Supplies: 

• Textbook: A Short Course in Digital Photography, 2nd Edition, London and Stone 
• A digital camera with either automatic or manual features 
• Memory card – 16GB or larger 
• One – 16 gig thumb drive, or several smaller capacity thumb drives 
• One – 24 X 36 piece of form board 
• One large roll of aluminum foil 

 
Some available suppliers are: 

• The Art Store (Commercial Art Supply) - 474-1000 
• OCC Bookstore - 498-2246 
• SU Bookstore – 443-9900 
• Johnson Camera – 446-0290 
• Ra-Lin Discount – 472-7886 
• Best Buy, Staples, Office Max, etc.…. 

Online Suppliers: 
• B&H Photo – www.bhphotovideo.com 
• KEH Camera – www.keh.com 
• Amazon – www.amazon.com 

 
Assignment List 

• Six photos from six different categories – 6 photos (one grade)  
• Lighting: North, South, East and West – 8 photos (one grade)  
• Metamorphosis – (one grade) 
• Photo Restoration – 2 photos. (before and after, one grade) 
• Composition - Beauty of Central New York – 6 photos. (one grade)  
• Image Control using a DSLR 

o Shutter Speed - (one grade) 
o Depth of Field - (one grade)  

• Frame It! – 3 photos (one grade) 
• Photoshop: History Brush, Color Replacement and Filters – (one grade)  
• Clashing Colors (one grade) 
• Andy Warhol Technique – (one grade) 
• Using Layers – (three different assignments, one grade)  
• Celebration of Community – 6 photos (one grade)  
• History of Photography presentation – (one grade)  
• Scavenger Hunt – (one grade) 
• Portraits - Studio (two different assignments, two grades)  
• Architecture using HRD – (one grade) 
• Midterm - Two-page written critique of a digital photo, or web-based photo gallery. 
• Final Portfolio – Presented digitally on your class blog. Must include of all critiqued projects and an additional five 

photos shot during the semester. 
 
Standards Crosswalks 

 
CCTC Standards NYS Standards 

Career Ready Practices 
CRP 1,2,4,6,8,11 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,57 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 3,4,6 

Pathway Standards 
AR-AV 1,2,3,4 

Literacy 
RST 1,2,4,7,8,9 
WHST 2,4,6,7 

 
  



MTC 400: Media Communications 400, Part II 
ART 123: Digital Design for the Non-Designer 

 
Course Description 

This course offers an introduction to the fundamental design concepts and software techniques used by graphic 
designers to produce printed communications. Students will achieve a proficiency in the software used for 
computer aided graphic design as well as in the process of organizing 2-dimensional space. This course may be 
used as an elective course for non-art majors only. No MAC experience necessary.  
 

Course Objective  
The student will achieve a general proficiency in the software used for professional computer graphic design 
concentrating on the following criteria:  

1. Software application for Page Layout. The ability to create artwork in a page layout software application 
(InDesign) with a basic understanding of the software’s functions, tools, menus and panels.  

2. Software application for Illustration. The ability to create artwork in an illustration software application 
(Adobe Illustrator) with a basic understanding of the software’s functions, tools, menus and panels.  

3. Software application for Photo Manipulation The ability to create artwork in a photo manipulation software 
application (Adobe Photoshop) with a basic understanding of the software’s functions, tools, menus and 
panels.  

4. 2-Dimensional Design. The ability to organize 2-dimensional space with a basic understanding of design 
concepts. (e.g. ads, brochures etc.)  

5. Critiquing. The ability to discuss and evaluate the class’s and the student’s own work as well as, 
demonstrating an understanding of constructive criticism and self-analysis.  

 
Grading  

Class assignments will be critiqued and graded as projects are due. Late assignments will have 10 points 
deducted from the grade. If you do not like a grade you received on any project, you have the option to redo your 
project and submit it with your original project before the last session. You may only submit a project once for 
reevaluation. The following chart shows letter grades and the point values that will be used in calculating your 
grade:  

A = 95-100  
A- = 94-90  

B+ = 87-89  
B = 84-86  
B- = 80-83  

C+ = 77-79  
C = 74-76  
C- = 70-73  

D+ = 67-69  
D = 64-66  
D- = 60-63  

F = 59 

 
Additional Course Policies 

Copyrighted Images: It is illegal to use another artist’s or designer’s images without permission; this includes 
scanning photos from magazines, or capturing images on the Internet. All images used in whole or in part for this 
class must:  

• be images you create  
• be images from the stock photography books or websites  
• be images you have obtained the rights to use  

 
Required Texts and Materials 

• InDesign CS5, Visual QuickStart Guide, Sandee Cohen, Peachpit Press  
• Illustrator CS5, Visual QuickStart Guide, Elaine Weinmann and Peter Lourekas, Peachpit Press 
• PhotoShop CS5, Visual QuickStart Guide, Elaine Weinmann and Peter Lourekas, Peachpit Press  
• Thumb Drive-for storing all work completed as well as assignments in progress  
• Mac lab with Creative Suite (InDesign, Illustrator and PhotoShop), color printer and scanner  

 
Course Schedule 

(This schedule is based on 3-hour sessions. Adapt timeframes as necessary Required content for Onondaga 
Community College’s Art 123. Sample projects are shown. Instructor may vary projects as long as content is 
maintained.) 

Week 1  Introductions, class structure and responsibilities Review 
course content. Mac OSX Desktop  

 

Week 2  InDesign CS5- Toolbox/Menus- Part I  SoundBox Ad 
Week 3  InDesign CS5- Toolbox/Menus- Part II  Orchids Project / SoundBox Due 
Weeks 4-5  InDesign CS5- Character styles, formatting, charts  Woods Flyer / Orchids Due 

Week 6 Illustrator CS5- Toolbox/Menus- Part I Illustrator Exercises / Woods Flyer 
Due  

Week 7  Illustrator CS5- Toolbox/Menus- Part II  Illustration TV trace / Exercises Due 



Weeks 8-9  Illustrator CS5- Type, Compound paths  Book Cover Project / Illustration Trace 
Due 

Week 10  PhotoShop CS5- Toolbox/Menus- Part I  Montage Project / Book Cover Due 

Week 11  PhotoShop CS5- Toolbox/Menus- Part II Scanning, 
Cloning, Drawing Tools, Color  

Cartoon/Scan Project / Montage 
Project Due 

Week 12  PhotoShop CS5- Ghosting, Combining Images  Cartoon/Scan Project Due 

Weeks 13-14  Bringing it all together. Creating documents that utilize one 
or more programs, transferring images between programs  

Final Project 

Week 15  Final Projects Final Projects Due 
 
 
Standards Crosswalks 

 
CCTC Standards NYS Standards 

Career Ready Practices 
CRP 1,2,4,6,8,11 

ELA 
11-12R 1,2,4,7 
11-12W 2,4,57 
11-12SL 1,2,5,6 
11-12L 1,2,3,6 

Cluster Standards 
AR 3,4,6 

Pathway Standards 
AR-AV 1,2,3,4 

Literacy 
RST 1,2,4,7,8,9 
WHST 2,4,6,7 

 
  



Course Scope and Sequence 
 

Time Key Learning Targets 
(Students will know and be able to) 

Week 1 
 
The Mac OSX Desktop 
 
Setting up the Desktop 
and Suitcase 

• Use Dock, Finder, Edit, View, Go, Window, Help, Trash and Empty, Eject, Force Quit Application 
• Use File/Folder concept  
• Create new folders- making, filing, storage  
• Save a document to a specific place  
• Access the server and setting up a folder  
• Move files from hard drive to Zip drive (or other storage unit)  
• Mount/eject disks  
• Use pull-down Desktop menus  

o Apple- Shut Down, Log Out, Force Quit, Restart  
o Finder- Empty Trash  
o File- New Folder, Open, Duplicate, Find  
o Edit- Undo, Copy, Paste  
o View-  
o Go- Computer, Connect to Server, Recent Folder  
o Window  
o Help  

• Use Dialog Boxes that pop up when a command is selected  
• Open an application- using the Dock  
• Open a file  
• Review work produced in the 3 software packages: InDesign CS5, Illustrator CS5, and PhotoShop  
• Make Disk icons show up on the Desktop. 
• Check Hard Disk and Connected Server.  
• Set personal Desktop preferences including desktop background and screen saver, mouse and dock 

preferences.  
• Set up Suitcase.  
• Load the ‘Basic’ Folder in Suitcase. 
• Enable global font activation for individual applications. 
• Select which applications globally auto-activate fonts  

Week 2 
 
InDesign: Toolbox and 
Menus, Part I 

• Open, minimize, and dock Panels (Palettes) 
• Use InDesign Tools including Selection and Direct Select, Pen, Type Tool (Palette), Pencil, Line, 

Frame and Rectangular Frame, Rotate, Scale, Free Transform, Eyedropper, Gradient (Palette), 
Scissors, Hand, Zoom, Fill and Stroke Boxes, Pull Out Menus, Tool Palette Dialog Window at Top  

• Use Pull-Down Menus including Apple: Recent Items, Force Quit, Restart, Shut Down, Log Out and 
InDesign: Hide InDesign (Dock), Quit InDesign and other menu commands: 

o File- New, Open, Document Set-Up, Print, Save, Save As, Place  
o Edit- Undo/Redo, Cut, Copy, Paste, Clear (delete), Duplicate  
o Layout- Margins and Columns, Rulers  
o Type- Tabs, Glyphs, Show Hidden Characters, Using the Character Panel  
o Object- Transform, Arrange, Fitting, Drop Shadow, Feather, Corner Effects  
o View- Zoom (Navigator), Fit Page in Window, Actual Size, Show Rulers, Snap  
o Window- Tools, Control, Color, Character, Paragraph, etc.  
o Dialog boxes- activated by certain commands.  

• Use InDesign tools 
o Make text/photo boxes and get texts, photos using x and y coordinates  
o Select a Box- activate a box (Photo or Text) with the arrow selection tool  
o Use the Character palette- Fonts (serif vs. sans-serif), size, leading  
o Edit color- CMYK, RGB, Pantone Spot Color  
o Copy a text 
o Create picture box with tool 
o Print and Page Set-up 

• Save frequently 
• Drag and drop files to copy to another location.  
• Read Chap. 1 and 2 InDesign CS5, Sandee Cohen.  
• Complete Project ‘SoundBox Ad’. 

Week 3  
 
InDesign: Toolbox and 
Menus, Part II 

• Review Picture Tool and Text Tool.  
• Use Character Palette - Character Styling. Sizing, Scaling, Baseline Shift.  
• Use Paragraph Palette - Left, Right, First Line Indents, Space Before, Space After, Drop Cap.  
• Select New Colors (Color and Swatches Panels).  
• Use Eyedropper to sample a color.  
• Perform Gradient Color Blend with Swatch Palette/Editing Gradient by double clicking Gradient 

Swatch Tool.  
• Place Picture/Text.  



• Scale of Photos using Command+Shift to scale box and contents.  
• Use Text Wrap panel.  
• Use Runaround preferences set in Control Panel.  
• Explain Leading, the baseline to baseline measurement, tracking, horizontal spacing between letters 

throughout a line or paragraph and kerning, spacing between a 2-character combination.  
• Apply drawing rules, changing weight and styles. 
• Explain and demonstrate layout design, e.g. Big Headline, Intro Copy, Subheads and Copy Block and 

Photo Arrangement. 
• Demonstrate how visual organization is accomplished, including: 

o Reading the manuscript to understand the information that will be communicated establishing 
a hierarchy of information 

o Establishing a hierarchy of type styling and usage for the document that parallels the 
hierarchy of information 

o Treating parallel information consistently throughout.  
o Thinking how the photos/graphics draw attention to design while visually supporting the 

content of the copy around it.  
o Using equal space between paragraphs, after all subheads and around all sides of photos.  

• Demonstrate how copyfitting is accomplished including adjusting type size, type font style, leading, 
tracking, column width and/or depth.  

• Use the Character and Paragraph panels to assign type and spacing specifications.  
• Keep text(s) within a single thought together, and grouped distinct from other unrelated text(s)  
• Use more space before and/or after heads- the larger the type, the larger the spacing. Space After on 

Paragraph panel.  
• Use more space between paragraphs- i.e. add half the leading measure between paragraphs- Space 

After on Paragraph panel.  
• Use one text box with 1, 2, or 3 columns.  
• Use separate text boxes for columns only when the design necessitates it.  
• Read Chap. 5, Working in Color, InDesign CS5, Sandee Cohen  

Weeks 4-5  
 
InDesign: 
Character Styles, 
Formatting, Charts  

• Demonstrate page layout- using copy, heads, tabs, background options, including: 
o Text Wrap 
o Typing on curve with the Type on a Path tool  
o Gradient fill  
o Effects (fx)  

• Make a chart, establish the width of the chart and place a background box, fill chart with a light color or 
image and copy and paste table text into a separate type box on top of the background box.  

• Read Chapter 5- Working with Color and Chapter 6- Fills, Strokes and Effects  
• Complete Woods Flyer Project 

Week 6  
 
Illustrator: Toolbox and 
Menus Part I 

• Demonstrate use of Illustrator toolbox. 
• Use Illustrator Drawing tools:  

o Ellipse and Rectangle tools and options / dialog boxes- (with option / shift keys).  
o Pen tool menu- anchor points for corners; and vectors for curves.  
o Add / Delete / Convert anchor points. 
o Pencil / Brush tool.  

• Use Illustrator Selection tools:  
o Selection and Direct Selection (Shift select for selecting multiple items).  
o Lasso.  
o Fill and Stroke, Stroke width (on Stroke panel).  

• Use additional Illustrator tools:  
o Zoom (magnifying glass) - use with option key to zoom out or use the keystrokes Command 

+ and Command - . 
o Type tools.  
o Knife / Scissors / Eraser tools.  
o Rotate / Reflect.  
o Scale/ Reshape / Shear.  
o Shear tools.  

• Use Illustrator Panels: 
o Color Swatches. 
o Pathfinder- add / subtract from selection (expand into one shape with Option key). 
o Stroke. 
o Color. 
o Layers. 
o Transparency. 

• Delete an item or point. 
• Use Illustrator Menus:  

o Edit > Undo, Cut, Copy, Paste, Paste in front, Clear. 
o Object > Transform, Arrange, Path > add anchor point. 
o Type > Font, Size, Character. 



o Effects. 
o View > Guides (hide, lock, make), Smart Guides, Rulers, Outline vs. Preview. 
o Window > Access to all the panels (palettes). 

• Read Illustrator CS5 Chapter 4 - Panels and Chapter 6 - Geometric Objects. 
• Complete Illustrator Exercises. 

Week 7  
 
Illustrator: Toolbox and 
Menus Part II 

• Demonstrate use of Illustrator toolbox, including: 
o Gradient Fill Palette  
o Gradient Tool- sets the direction of the gradient within a selected item  
o Eyedropper Tool- samples colors that are present in a piece of art or photo  
o Option-click with the Eyedropper tool to apply the current attributes to another shape  
o Pathfinder Palette - joining shapes  
o Pen Tool - for irregular shapes  
o Shift Key - for perfect circles, squares and stars  
o Layers Palette - Arranging, effecting, locking and viewing  
o Arrange - Bring to front/send to back (Object menu> Arrange>)  
o View > Outline (vs. Preview)  
o Navigator - Work in Close on fitting  
o Transform Palette  

• Read Chapter 10- Fill and Stroke and Chapter 12- Reshape 
• Complete Illustration Trace Project 

Weeks 8-9  
 
Illustrator: Type, 
Compound Paths 

• Review and use Illustrator Tools, including: 
o Rotate/Reflect  
o Free Transform-  
o Scale/Shear/Reshape tools  
o Twist 
o Liquify (Distortion) Tools 
o Mesh Warping 
o Mesh Tool  
o Object-Arrange, Transform (Tool), Group, Envelope Distort, Text Wrap  
o Filter-Distort, Stylize  
o Effect-Distort and Transform, Stylize (shadows, etc.), Warp  
o Creating a shadow 
o Type as outline (ungroup to alter individual letters)  
o Compound paths 
o PathFinder palette-  
o Transform palette 
o Live Trace 
o Live Paint -Selection Tool and PaintBucket  

• Read Illustrator CS5 Chapter 11- Transform and Chapter 19- Create Type  
• Complete Book Cover Project 

Week 10  
 
PhotoShop: Toolbox 
and Menus Part I 

• Describe the uses of PhotoShop CS professional-level software. 
• Explain the relationship between pixels and resolution.  
• Explain how the needed level of resolution is determined depending on output and use. 
• Explain and demonstrate use of color modes including: 

o RGB - Red/Green/Blue. 
o CMYK - Cyan/Magenta/Yellow/Black.  
o Grayscale. 
o Bitmap. 

• Explain and demonstrate use of PhotoShop tools, including Selecting: Marquee, Lasso, Magic Wand 
Drawing: Paintbrush, Pencil, Airbrush, Eraser, Type Transforming: Scale, Rotate, etc. Changing view: 
Hand, Zoom  

• Explain and demonstrate use of PhotoShop MENUS- File: New, Open, Close, Save Edit: Undo, Copy, 
Paste, Transform Image: Mode, Adjustments Filters Window: Show Color, Swatches, Layers  

• Explain and demonstrate use of PhotoShop PALETTES- Color, Swatches, Layers  
• Select/Move layers, including selecting, stacking order, opacity, Foreground/Background colors  
• Print a PhotoShop image  
• Read Photoshop CS5, Weinmann and Lourekas, Read Chapter 5, Workspaces and Chapter 6, Panels 
• Complete montage project 

Week 11  
 
PhotoShop: 
Toolbox/Menus, Part II 
– Scanning, Cloning, 
Drawing Tolls, Color 

• Open Scan in Photoshop.  
• Change Mode from Bitmap to Grayscale. 
• Use Adjust Image>Brightness/Contrast to achieve bright Black and White Image.  
• Use the Eraser tool to eliminate unwanted items. 
• Use Image> Image Size to set dpi.  
• Find a photo from a stock photo supplier and save image. 
• Open Photo in Photoshop. 
• Use Magic Wand to select Image and save to Photo file. 
• Use Edit>Transform>Scale to size art.  



• Use the Move Tool to place art.  
• Color an image.  
• Add Shading, Highlights, and Drop Shadow with brush to an image.  
• Make a mask or to add a custom colored shape to an image using Paths palette.  
• Complete Cartoon/Scan Project. 

Week 12  
 
PhotoShop: Ghosting, 
Combining Images 

• Ghost a photo. 
• Create a vignette or feathering. 
• Create a silhouette. 
• Use filters. 
• Making a color photo a duotone  
• Review Text Wrap  
• Type on curve  

Weeks 13-14  
 
Bringing It All Together 

• Create documents that utilize one or more programs, transferring images between programs. 
• Complete Final Project: An ad or brochure utilizing Illustrator to create a logo, PhotoShop to create the 

main image, and InDesign for layout and type setting/design.  

Week 15  
 
Complete Final Project 

• Complete Final Project 

 
 


